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Company and Product Information 

ePlan Services Pty Ltd is a surveying information technology company based in Victoria. The 
company is staffed by practising IT professionals and licensed surveyors with a long history in 
cadastral surveying and software development. 

ePSALON is an off-the-shelf software package developed and distributed by ePlan Services Pty Ltd 
for the generation of state government compliant ePlan format files. ePSALON works with existing 
survey drafting and computations packages, such as GeoCivil and AutoCAD, converting their data 
into ePlan compliant files. This documentation outlines firstly, how to prepare data in third party 
survey packages such as GeoCivil, and secondly, how to process this data in ePSALON to 
successfully output ePlan data. 

Copyright Information 
The Copyright © of ePSALON software and associated documentation is owned by ePlan Services 
Pty Ltd. The ePSALON software is furnished under a licence which grants the licensee permission to 
use the software modules so licensed. Software furnished under a particular licence, or any part or 
copy of the software, may not be used on more than one computer at a time. ePlan Services Pty Ltd 
have no liability to the purchaser or any other entity, with respect to any liability, loss, or damage 
caused, directly or indirectly by this software, including but not limited to, any interruptions of service, 
loss of business, anticipatory profits, or consequential damages resulting from the use of or operation 
of this software. 

 

 

Contact and Company Details 

ePlan Services Pty Ltd 
ABN 961 514 66 189 
 
PO Box 1193 
Camberwell VIC 3124 
 
Tel: +61 3 9809 0011 
Fax: +613 9809 0022 
Web: www.epsa.com.au 
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Assistance Operating ePSALON 

For assistance with ePSALON: 

 

By phone: +61 3 9809 0011 during business hours 

By email: ken@epsa.com.au or geoff@epsa.com.au  

Assistance is also available through registered login to our website at www.epsa.com.au 
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ePSALON System Requirements 

You need to satisfy the following system requirements to be able to effectively use ePSALON: 

§ Intel® Pentium® III or later processor, or compatible 

§ Operating System:  

a. Microsoft® Windows 7 (32 bit) 

b. Microsoft® Windows 7 (64 bit) 

c. Microsoft® Vista (XP is preferred) 

d. Microsoft® Windows® XP (Professional, Home Edition, or Tablet PC Edition) 

§ Minimum 512 MB RAM (1GB recommended) 

§ 1024x768 VGA with true colour (minimum) 

§ Microsoft® Internet Explorer 4 (or later version) 

§ CD-ROM drive 

§ Mouse or other pointing device 
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Licensing ePSALON 

Trial License 
ePSALON is shipped with a trial license, which allows unrestricted use of all of ePSALON’s 
functionality for the duration of the trial period. After the trial period has ended, the license expires and 
ePSALON will no longer run without upgrading to a full license. 

Contact ePlan Services Pty Ltd (ph: +61 3 9809 0011, web: www.epsa.com.au) to upgrade your 
license. 
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Installing an ePSALON License 

ePSALON requires license activation in order to run unrestricted. ePSALON will utilise one of a 
variety of licensing schemes in order to run: 

§ Standalone License locked to a USB hardware key (dongle). One license is installed on any 
computer, and allows ePSALON to run when a specific dongle is plugged into it. 

§ Standalone License locked to particular computer.  

§ Trial License. Allows ePSALON to run for a period of time. Will not allow ePSALON to run once the 
trial period has expired. 
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  Data 
Preparation 

This chapter describes how to prepare survey data 
for ePSALON using GeoCivil. 
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Data Preparation Using GeoCivil 

ePSALON works with existing survey drafting and computations packages, such as GeoCivil and 
AutoCAD, converting their data into ePlan compliant files. The primary geometry of a subdivision is 
captured using one of these packages prior to its export to ePSALON. This section of the 
documentation outlines how to prepare data in GeoCivil prior to its export to ePSALON. 

GeoCivil Usage 
GeoCivil is a Windows based application that aids and manages the manipulation and development of 
three dimensional spatial data used within the land development, surveying, engineering design and 
planning industries. The toolset that comes with GeoCivil includes generic coordinate and geometric 
functionality, an integrated drawing environment plus tools that allow data processing to be 
performed. 

GeoCivil commands can be accessed via drop down menu, toolbar buttons and also via option 
numbers which are typed into the command line at the bottom of the application window. Note that by 
clicking the main graphic window with the right mouse button (RMB) many of the menu options of 
particular relevance to ePSALON can be quickly accessed through a pop-up menu. 

GeoCivil Settings 
1. In preparing data for ePSALON it is advised that the following toolbars (see image below) are 

opened. This is done by right clicking on the menu bar at the top of the application window:                                   

 
 

2. On the Level and Feature toolbar at the top of the application window set the Level to 
CADASTRAL 

3. Set the Coordinate System in GeoCivil to MGA Zone xx. At the bottom left of screen, click the 
second information box from the left and from the “Change Coordinate System” form that 
appears from the drop-down text box select the correct MGA Zone. Then click the OK button. 
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Relevant GeoCivil Functionality 
Much of the required GeoCivil functionality for generating ePlan compliant data is contained on the 
GeoCivil Right Mouse Button (RMB) popup menu. A command process can be exited at any time by 
pressing and holding the “Esc” key. Sometimes this is necessary between commands that expect 
repeated executions of the same procedure – just press and hold the “Esc” key. 

The following graphics show which GeoCivil menu options are available through the RMB, and at right 
shows the command line option number for each function. 

Under Create Elements you will find: 

  

Point By Traversing  -  creates a Point element of the current feature by bearing and distance from 
the current Standpoint. The new Coord becomes the Standpoint. 

Point By Radiation Traversing  -  creates a Point element of the current feature by bearing and distance from 
the current Standpoint. The Standpoint does not change. 

Line By Traversing  - creates a Line element of the current feature, by bearing and distance , 
connecting the new standpoint to the new Coord, which becomes the current 
standpoint. 

Line By Radiation  -  creates a Line, connecting the “Join Coord” (generally last Coord created). 
The Standpoint remains unchanged. 

Line from SP by Radiation -  creates a Line element of the current feature, from the Standpoint to the new 
Coord.  The Standpoint remains unchanged. 

Line (Join Coords) -  creates a Line element of the current feature, joining two clicked Coords. 

Arc  -  creates an Arc element of the current feature, from the Standpoint, defined by 
radius, arc length and chord bearing 

Point (Along Line) -  creates a Point element of the current feature (or Line if the Join Toggle is 
ON) a distance along a selected Line (or between two clicked Coords). 

Point (Two Offsets) -  creates a Point of the current feature by square offsets, from two lines or two 
coordinate pairs. 

Point (Chainage & Offset) -  creates a Point of the current feature by running distance and a square offset. 

Point (At Existing Coord) -  creates a Point of the current feature, adopting the location of an existing 
Coord. 

 

  

   4 
   5 
1031 
1032 
1377 
  15 
  19 

   
28 

1686 
6 

121 
1018 
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Edit Elements provides: 

  

Change Feature -  changes the feature of a clicked element to the current feature. 

Change Vector -  changes the bearing and/or distance of a Line or between two clicked 
Coords. 

Change Vector & Affected -  changes the bearing and/or distance of a Line or between two clicked 
Coords, and applies the resultant coordinate shift to all subsequently 
created Coords, linked by Standpoint with the altered Coord. 

Delete Element -  deletes a clicked Point, Line or Arc element. 

Delete a Point -  deletes a clicked Point element 

Assign ID Name/Number -  assign a unique alpha/numeric identifier to a clicked Coord 

Assign Description -  assign a description to a clicked Point, Line or Arc element. 
 

Measure provides: 

 

Misclose -  back-tracks along the current traverse (line sequence) to its 
commencement and computes the closing vector. An opportunity is 
given to remove the misclose using a Bowditch adjustment. 

  40 
  33 
1017 

  
31 

1226 
1171 
  10 

  62 
1226 
1171 
  10 
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Vector (Brg & Dist) -  computes the bearing and distance of a clicked Line or between two 
clicked Coords. 

Offset -  computes the distance from a clicked Coord, square to a clicked Line. 

Area, Perimeter, Centroid -  computes the area, perimeter length and centroid coordinates of the 
current polygon. 

 

Parcels provides: 

  

 

Distortion provides: 
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Reference Labels provides: 

  

ePlan provides: 

 

  

 171 
1068 
1069 
1358 
1002 
1111 

1950 
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Background provides: 

  

Note: The Background functionality is setup to display the Victorian cadastre as background to your 
project data. It converts the DWG format tiles to a GeoCivil format and displays the relevant tiles. This 
can be readily modified to accommodate any form of background graphics. 

Feature Capture 
The key features to be captured in GeoCivil are: 

• Traverses and Radiations connecting Monuments and other survey marks 
• Boundary Lines defining the edges of Title, Roads, Lots, Reserves, Easements and the like 
• Monuments comprising PSMs, PCMs, RMs, Title Pegs and the like 
• Parcels (or polygons) representing Title being subdivided, Roads, Lots, Reserves, Easements 

and the like 
• Abutting parcels (roads and crown allotments, etc) 
• Connection to a road intersection, a bend in a road or crown boundary 
• Plan features (optional) 

The next sub-sections describe how these various features should be captured using GeoCivil. 

Note: Although GeoCivil supports working directly on MGA, it is common practice to create or capture 
survey traverses and subdivision boundaries on an arbitrary coordinate system and transform onto 
MGA at a later stage. Cadastral data is generally represented by Line and Arc elements, with Point 
elements being created at node Coords as appropriate (e.g. survey mark, title peg, etc) 

Traverse and Radiation Capture 
In this section traverses and radiations referenced in the Abstract of Field Notes are captured.  

1. After setting the current feature (e.g. “Survey Mark - Placed” or “PCM – Found”), create a 
starting Coord of known coordinate value (e.g. a PM) or simply commence ‘traversing’ in 
which case a default starting Coord will be created at E=1000, N=2000. 

1559 
1560 
1561 
1681 
1566 

1565 
1562 
1563 
1696 
1564 
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2. If creating a point element by coordinate input: a Point of the current Level and Feature will be 
created by mouse click or keyboard entry of X,Y coordinates 

Procedure: 
a. From the Insert menu, choose Point > X, Y Coordinates; or click 

icon ; or key in command line option 3 
b.  Enter easting, northing OR click spot. 

3. Set the Feature to “Traverse”. 
4. Create a line element by bearing and distance input: a Line of the current Level and Feature 

will be created by bearing and distance, the new Coord becoming the next stand point. 

Procedure: 
a. Use RMB (Right Mouse Button) > Create Elements > Line By 

Traversing; or click icon  ; or key in command line option 1031 
b. Select the current stand point, if it is not already selected (this 

will be the monument point just previously keyed in – select it 
using the mouse cursor) 

c. Enter bearing from the current stand point for the traverse line to 
be created. Enter ] to add 90 degrees to last bearing. Enter [ to 
subtract 90 degrees from last bearing. Click on a Line or pair of 
points to adopt that bearing. Add + or - to the end of the bearing 
to reverse it. 

d. Enter the distance. Click on a Line or pair of points to adopt that 
distance. 

e. Repeat the process with the stand point advancing to the created 
point. 

Note: Just press Enter key to accept the bearing from the previous 
entry   
 
Note that the Define Stand Point command (  , command option 7) 
can be used to return to an existing start point from which to traverse 
in another direction. First press the Esc button to exit the current 
“Create Element” mode then Define the Stand Point. 
 
The Pan and Zoom buttons can be used to better show those parts 
of the data of importance at any particular stage.   

5. Create radiation elements in a similar fashion but using the “Create Lines – Radiations” tool - 
by bearing and distance input: a Line of the current Level and Feature will be created by 
bearing and distance, radiating from a fixed stand point. 

Procedure: 
a. Set the Feature to “Radiation to Adopt”, “Radiation to 

Occupation” or “Radiation to Survey Mark” as appropriate. 
b. Use RMB > Create Elements > Line from SP by Radiation; or 

key in command line option 1377 
c. Enter bearing from the current stand point for the radiation line to 

be created. Enter ] to add 90 degrees to last bearing. Enter [ to 
subtract 90 degrees from last bearing. Click on a Line or pair of 
points to adopt that bearing. Add + or - to the end of the bearing 
to reverse it. 

d. Enter the distance. Click on a Line or pair of points to adopt that 
distance. 

e. Repeat the process 
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Note: At any stage of the traverse and radiation creation process a Point element may be created at a 
traverse or radiation node by setting the current feature as appropriate (e.g. Survey Mark) and then 
using RMB > Create Elements > Point at Existing Coord; or key in command 1018, Create a Point at 
an Existing Coord.  

Boundary Line Capture 
In this section the lot boundary lines of the subdivision are captured.  

As a general rule the outer boundary of a subdivision should be captured first and is generally created 
by the entry of bearings and distances. After entering the bearing and distance for the closing line, the 
“misclose” should be analysed and, if within an acceptable tolerance, removed by applying a 
Bowditch adjustment. The results of the adjustment are reported to a log file. Use the Misclose 
command: 

RMB > Measure > Misclose (Option 62) 

The internal boundaries of a subdivision should then be captured (roads, lots and reserves). They are 
created by a combination of bearing and distance entry and a range of coordinate geometry routines. 
Similarly to the subdivision outer boundary, small misclosures should be identified and removed using 
the “Misclose” Option 62. 

The capture of the subdivision boundary lines is fundamentally the same as the capture of the 
traverse and radiations, as follows: 

1. Start from an existing Coord. This could be the end of a “Radiation to Adopt” line already 
digitised – set the Standpoint to this location. Alternatively create a point element of 
appropriate feature type (such as “Peg – Placed”) by coordinate input: a Point of the current 
Level and Feature will be created by mouse click or keyboard entry of X,Y coordinates: 

Procedure: 
c. From the Insert menu, choose Point > X, Y Coordinates; or click 

icon ; or key in command line option 3 
d.  Enter easting, northing OR click spot. 

2. Then set the Feature to “Crown Boundary” or “Lot Boundary”, or a similarly appropriate 
feature type. 

3. Create a line element by bearing and distance input: a Line of the current Level and Feature 
will be created by bearing and distance, the new Coord becoming the next stand point. 

Procedure: 
a. Use RMB (Right Mouse Button) > Create Elements > Line By 

Traversing; or click icon  ; or key in command line option 1031 
b. Select the current stand point, if it is not already selected (this 

will be the monument point just previously keyed in – select it 
using the mouse cursor) 

c. Enter bearing from the current stand point for the traverse line to 
be created. Enter ] to add 90 degrees to last bearing. Enter [ to 
subtract 90 degrees from last bearing. Click on a Line or pair of 
points to adopt that bearing. Add + or - to the end of the bearing 
to reverse it. 

d. Enter the distance. Click on a Line or pair of points to adopt that 
distance. 

e. Repeat the process with the stand point advancing to the created 
point. 
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Note: Just press Enter key to accept the bearing from the previous 
entry   
 
Note that the Define Stand Point command (  , command option 7) 
can be used to return to an existing start point from which to traverse 
in another direction. First press the Esc button to exit the current 
“Create Element” mode then Define the Stand Point. 
 
The Pan and Zoom buttons can be used to better show those parts 
of the data of importance at any particular stage.   

4. After completing the surround boundary line of the subdivision check the polygon misclose 
with the Misclose command. This will perform a Bowditch adjustment on the last sequence of 
Lines. The sequence is created automatically commencing at the most recently created Line 
and progressing back through the Line elements until a discontinuity is encountered (i.e. until 
we reach the end of a Line which does not connect to another line).  

Procedure: 
a. Use RMB (Right Mouse Button) > Measure > Misclose; or  

key in command line option 62 
b. Use the screen cursor to identify the closing point. This is 

often the first Coord in the sequence but may be any other 
Coord 

c. Name the Adjustment, for instance “outer boundary” 
d. An option is given to remove the angular misclose, if a 

closing angle has been observed – more likely to be the case 
when closing a traverse 

e. A form appears listing the misclose and asking whether to 
make the adjustment. If the misclose is within an acceptable 
tolerance the adjustment should be made. 

f. If the adjustment is made a report listing the adjustments 
made and associated parameters is saved to the work 
directory and also listed to the screen. The end point of the 
lot polygon is closed onto the start point. 

 

5. Now repeat step 3 to create the internal lot boundaries of the subdivision, moving the 
Standpoint and changing the Feature setting as required. To close onto an existing point in 
the surrounding lot boundary exit the Line By Traversing tool (use Esc button) and use the 
“Join Coords with Line Elements” option: Lines are created by joining selected Coords.  

Procedure: 
a. Use RMB (Right Mouse Button) > Create Elements > Line 

(Join Coords); or click icon  ; or key in command line 
option 15 

b. Using the cursor select the points to be joined 
c. On completion, hit the return key on the keypad to exit the 

function 
 
Note that ePlan requires that existing lots – those being subdivided – 
are captured as “Extinguished” lots, and that their full spatial extent is 
shown – so these will need to be captured at this stage in a similar 
fashion.  
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Monument Capture 
In this section monuments found, placed and otherwise referenced in the Abstract of Field Notes are 
captured. This is a two-step process starting with the placement of the point feature followed by its 
attribution. 

Monuments are permanent marks, primary cadastral marks, reference marks, boundary marks, 
instrument points, and occupation such as fences and walls.  

ePlan requires that monuments have the following attributes attached: type, state, condition, origin 
survey, ID number, description, and date, where these refer to: 

type:  the nature of the mark, whether peg, pipe or the like 
state:  whether found or placed or the like 
condition: whether damaged or the like 
origin survey: the record plan number for the survey in which the mark was placed (not required for 

new marks) 
ID number: the PM unique 9 digit number, if relevant, for example, 355206260 
description: the PCM number, PM name, or RM number, if relevant, for example, TARNEIT PM 

626, PCM114450256, RM 12, or further clarifying remarks about the nature of the 
monument, such as “Brass plaque in concrete with beacon” 

date:  the date on which the mark was registered in the state database 
 

The following are valid monument types: 

Occupation 
Bolt 
Bottle 
Chisel Cut 
Cross Head Nail 
Deep Driven Rod 
Drill Hole 
Drill Hole with Wings 
Dumpy Peg 

Etch 
G.I. Nail 
HSM 
Nail 
Nail in Peg 
Nail in Rail 
Not Marked 
Offset Nail 

Peg 
Peg and Trench 
Pin 
Pipe 
Plaque 
Plug 
Rivet 
Rod 
Reference Tree 

Screw 
Spike 
Star Picket 
Star Picket with Collar 
Star Steel Post 
Steel Star Picket 
Survey Nail 
Survey Post 
Unknown 

 
The following are valid monument states: 

Abandoned 
Damaged 
Destroyed 
Disturbed 
Found 

Leaning 
Loose 
Nipple Damaged 
Not Found 
Not Used 

OK 
Origin 
Placed 
Plaque Missing 

Removed 
Replaced 
Suspect 
Unknown 
Unstable 

 

The capture and attribution of monuments is as follows: 

1. Set the Feature to the appropriate type for the monument to be captured, such as “Survey 
Mark – Placed”, “PSM – Found”, “Peg – Placed” or the like. Occupation features are also 
considered monuments and should be captured as part of this process.  

2. Create a Point of the current Feature at an existing Coord: a Point of the current Level and 
Feature will be created by mouse click on the screen 

Procedure: 
a. Use RMB (Right Mouse Button) > Create Elements > Point (At 

Existing Coord); or click icon  ; or key in command line option 
1018 (or if the Coord does not yet exist from the Insert menu, 
choose Point > X, Y Coordinates; or click icon ; or key in 
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command line option 3 and then Enter easting, northing OR click 
the relevant spot on the screen) 

b. Select the Coord on the screen where the new monument is to 
be created – for instance at the intersection of traverse lines or 
boundary lines 

 
3. Assign the attributes to the monument. 

Procedure: 
a. Use RMB (Right Mouse Button) > ePlan > Assign Monument 

Attributes or key in command line option 1951 
b. Use the following form to enter the attributes. Drop down menus 

are provided for the type, state, condition and origin survey 
fields. The monument to be attributed should first be selected 
using the “Select Monument” button and then attributed with the 
“Assign Attributes” button. If the Monument Attributes form does 
not reappear after selecting the point feature – the feature failed 
to be selected – and it is necessary to repeat the command in 
section “a” above. If more than one feature is selected a “tooltip” 
window appears listing all the possible selections and it will be 
necessary to select from this form the intended feature. 

 

 
 
Note that to check that a feature has been correctly attributed hover 
the cross hair over the feature so that a temporary popup appears 
showing the features attributes. The right arrow key on the keyboard 
can be used to scroll through other features in the vicinity of the 
curser.  
 

4. Repeat this process until all the monuments are captured and attributed. 

Parcel Capture 
In this section the capture of “parcels” is described. Parcels are Lots, Roads, Reserves, Easements 
and the like – each of which are different “classes” of parcel. The following is the complete list of valid 
parcel classes: 

Lot  Easement  Crown Parcels Township  
Consolidated Lot  Restriction  Crown Allotments  Part Parcels 
Common property Owners Corporation  Crown Portions  Nested Parcel for linkages 
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Reserve  Stage Lot  LGA   
Road Depth Limitations  Parish   
 
ePlan recognises two general types of parcel: Primary and Secondary. Primary parcels (lots, roads, 
common property, reserves and crown parcels) are constructed from the boundary lines already 
captured, secondary parcels (easements, restrictions and depth limitations) are not constrained to this 
degree but must connect to existing features already captured. 

The following section describes in greater detail the capture requirements of the most common parcel 
classes. Note that Multi-part parcels are identified by the addition of -p1, -p2, etc to the primary parcel 
name. 

A. Lots 
Lots can be single or multi-part and must be closed polygons. Parcels being subdivided 
(extinguished parcels) are also required to be captured. Lots have the following attributes 
which should be populated: 

name 1, 2, 3, etc 
class Lot 
state created 

affected 
extinguished OR 
existing 

parcelType Single 
Multipart OR 
Part 

area in square metres 
 

B. Roads 
Roads can be new or existing. ePSALON captures existing roads as part of Abuttals in a 
section described later in this document.  New roads have the following attributes which 
should be populated: 

name R1, R2, R3, etc 
class Road 
state created 

affected 
extinguished OR 
existing 

parcelType Single 
area in square metres 
owner (the vesting authority) 

 
C. Reserves 

There are numerous types of reserve, such as recreation reserves, municipal reserves and so 
on. Reserves have the following attributes which should be populated: 

name RES1, RES2, etc 
class Reserve 
state created 

affected 
extinguished OR 
existing 

parcelType Single 
Multipart OR 
Part 

area in square metres 
owner (the vesting authority) 
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D. Common Property  
Common Property has the following attributes which should be populated: 

name CM1, CM2, etc 
class Common Property 
state created 

affected 
extinguished OR 
existing 

parcelType Single 
Multipart OR 
Part 
 

E. Crown Parcels (allotments and portions) 
Crown Parcels have the following attributes which should be populated: 

name 12~3 (for CA12, Sec3 for example), 5 (for Portion 5,for example) 
class Crown Allotment OR Crown Portion 
state affected 

extinguished  
existing OR 
referenced 

parcelType Single 
area in square metres 

 
F. Easements 

Easements can have independent geometry from the boundary line features but nevertheless 
must be located relative to the boundary line features by abuttal to a boundary line or 
radiation from a cadastral corner. 
 
Easements have the following attributes which should be populated: 

name E1, E2, etc 
class Easement 
state created 

affected OR 
extinguished  

parcelType Single 
Multipart OR 
Part 

useOfParcel the type or use of the easement 
 

The following are valid useOfParcel entries: 

Air Supply 
Flow of Air 
Passage of Air 
Air Exhaust and Ventilation 
Carriageway 
Drainage 
Drainage and Floodway 
Drainage and Sewerage 
Drainage and Waterway 
Erosion 
Fire Access 
Fire Escape 
Fire Egress 
Floodway 
Flooding 
Flow of Light and Air 

Flow of Light 
Passage of Light 
Overhanging Eaves 
Overhanging Spouting 
Overhanging Balcony 
Party Wall 
Chimney 
Passage of Light and Air 
Pipeline or Ancillary Purposes 
Powerline 
Right of Entry 
Sewerage 
Soakage by Water 
Submergence 
Walkway 
Walkway in the event of ‘activity’ in ‘specific 
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Footway 
Gas Distribution Pipeline 
Gas Transmission Pipeline 
Supply of Gas 

location’ 
Waterway 
Waterway Management 
Way 

 
The following are valid useOfParcel entries – but require further qualification: 

Channel 
Data Transmission 
Supply of Electricity 
Transmission of Electricity 
Ground Water Monitoring 
Irrigation 
Loading and Unloading Heavy Equipment 
Mail Collection 
Overhanging Projections 
Sanitary Convenience 

Supply of Recycled Water 
Supply of Water 
Support 
Telecommunications 
Underground Effluent Disposal 
Use of Stairway 
Vehicle Parking 
Waste Disposal 
Wetland 

 
Note that there are some additional useOfParcel entries that should be referred to Land 
Registry for an opinion prior to use, and some “one-off” type entries. 
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The relevant GeoCivil command option numbers and icons for the creation of parcels are from the 
following options. 

  

 

The capture and attribution of parcels is as follows. 

1. Set the Class of the Parcel to the appropriate type such as “Lot”, “Road” or the like. In 
GeoCivil the Class of the parcel is set prior to its capture using the Subdivision Design form.  

Procedure: 
a. Use RMB (Right Mouse Button) > ePlan > Set Subdivision 

Parameters; or Set Current Parcel Class; or key in command line 
option 1950. The following form appears. 

Options – Estate Design Configuration  Option 3000 

Define Parcel by Node Coords   Option 1071  

Create Polygon Enclosing Mouse Click   Option 1149  

Delete Parcel Node    Option 1150 

Insert Parcel Node     Option 1151 

List Parcel Coords    Option 1238 

Re-define Land Parcel Coords   Option 1074 

Add or Edit Parcel Name   Option: 1044  

Add or Edit Parcel Class   Option 1033 

Move Parcel Boundary to Achieve Area  Option 1016 

Re-compute Area of Parcel   Option 1042 

Re-compute Area of All Parcels   Option 1043 

Subdivision Lot Check    Option 75 

Parcel Report     Option 1012 

Re-locate Parcel Name/Number   Option 1007 

Re-Locate Parcel Area    Option 1008 

Re-locate Parcel Centroid   Option 1009 

Delete a Parcel     Option 1039 

Delete All Parcels    Option 1082 

Delete Parcel by Array Position   Option 1578 

Re-instate a Parcel    Option 1147 

Define Parcel Fill Range and Colour  Option 465 

Hatch All Parcels    Option 1019 

Display Parcel Info On Grid   Option 1003 
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b. Select the Parcels tab 
c. Select the Class (radio button) that is to be current, for instance 

“Lots”. Click the “Apply” button and then Close the form.  

Note that Parcel names/numbers may be assigned at the time of 
parcel creation by ticking Assign Parcel Name Upon Creation on 
the Environment Manager, General tab. Alternatively the 
name/number can be assigned retrospectively using RMB > 
Parcels > Add or Edit Name ; or keying in command line option 
1044. The Environment Manager is found under the Tools drop 
down menu. The following is the Environment Manager form. 
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d. Use RMB (Right Mouse Button) > Parcels > Define; or click the 
icon (see above) ; or key in command line option 1071. The 
following form appears. 

e. Select the parcel coords with a LEFT mouse button click. The 
following key / mouse button combinations can be used:  

RIGHT – Close polygon 

SHIFT LEFT – Arc centre, or click on the arc 

SHIFT RIGHT – Remove last node 

CTRL LEFT – Start Irregular Boundary 

ALT LEFT – End Irregular Boundary 

After closing the parcel, enter the parcel name if requested. Note 
that the pan/zoom buttons can be used during the coord 
selection process to ensure that the correct coord is selected. 

f. Return to step (d) to complete capturing all the parcels of the 
current Class. 

g. Return to step (a) to change the parcel Class and then capture 
instances of that Class. 

 
Note that the State, parcelType and useOfParcel fields are 
populated with the ePSALON application, later in the data 
capture process. 

 

When capturing Secondary parcels, such as easements, the following should be noted. 

A. Easements 
• Easements are captured with one parcel for each interest (e.g. drainage, pipeline, 

etc) with a naming convention of E1, E2, and so on as previously noted, plus with the 
addition to the primary parcel name of -p1, -p2, etc for multi-part parcels (comprising 
more than one polygon).  

• The easement beneficiary may be an Authority (owner) OR Land on the plan (title 
reference) and must be either Appurtenant or Encumbering. 

• Implied easements do not require a parcel reference. 

 
B. Restrictions/Covenants 

• A restrictive covenant is created as a parcel to which attributes are assigned on the 
Covenants tab of the Subdivision Design & Cadastral Survey Configuration form; or 
RMB> ePlan > Define Restriction or Covenant. The following form appears. 
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• Restrictions or covenants should be named RST1, RST2, etc.  
• Each Restriction parcel needs to be assigned the Burdened Parcels and Benefited 

Parcels – these are entered into the form (above) using the Names of the parcels. 
• The covenant details are assigned as a block of text entered in the form (above). 

 

C. Common Property and Owners Corporation 
• Common Property parcels can be single or multi-part and must be accompanied by 

an Owners Corporation. 
• When capturing the spatial extent set the parcel class to Reserves > COMMON 

PROPERTY and then fully define the polygon nodes. Assign a parcel name of the 
form CM#. 

• Then set the parcel class to Admin > OWNERS CORPORATION and create a 
Pseudo Parcel.  

 

D. Depth Limitation 
• Depth Limitation parcels adopt a name based on its origin, which is generally the 

original crown allotment parcel(s) e.g. DL-13~3\PP1234 with 50 feet commonly being 
the depth. 

• In GeoCivil a parcel has a Z value attribute. If this field holds a negative value it is 
assumed to be a depth limitation. 
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• Use the command RMB > Parcels > Add or Edit Depth Limit (Option 1137) to assign a 
depth limitation to the parcel.  

Abuttal Capture 
In this section the capture of abutting detail such as roads and crown allotments, and the capture of a 
connection to the subdivided land, such as a connection to a road intersection, a bend in a road or 
crown boundary are described. 
 
Most, but not all, of the abutting information required for ePlan can be downloaded through the 
SPEAR application. 
 

Procedure: 
a. Start and login to the SPEAR application. At the top right of the 

main application window click the dropdown and select the 
“ePlan Data Request” option, as illustrated below. 

 

 

 

b. In the search window that appears (see below) key in the 
property details. 
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c. Select the “Draw polygon for Digital Data Request” icon (see 
below) on the menu bar of the application. 

 

d. Draw a polygon around the entire land area in the subdivision 
(see below). Extend the polygon onto the adjacent roads and 
parcels as these abutting parcels need to be included in the 
extracted data file. 

 

 

 

e. Select the survey marks listed under the Digital Data tab in the 
frame to the right of the application window and then press the 
download button (see below). This file contains the abuttal 
information. The file should be saved and later, using ePSALON, 
will be included and meshed with the output from GeoCivil.  
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Connection Capture 
In this section the capture of connection detail is described. This section is still being compiled and 
will appear here in full soon. TO BE COMPLETED. 

Subdivision Plan Generation 

In this section the automated generation of a Plan of Subdivision from the completed GeoCivil file is 
described. This section is still being compiled and will appear here in full soon. TO BE COMPLETED. 
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Field Notes Generation 

In this section the automated generation of an Abstract of Field Notes from the completed GeoCivil 
file is described.  
 
GeoCivil includes tools specifically aimed at structuring the survey and cadastral data to enable the 
integration of a ‘distorted’ view of traverses and radiations. Individual or a selection of Coords can be 
moved to enhance clarity of viewing. The displayed bearings and distances being computed from the 
‘true’ coordinates. 
 
Road names can be referenced to the centreline and displayed where the current view window cuts 
these reference polylines. 
 

Distortions 
Most of the relevant functionality to create a ‘distorted’ field notes view of the data may be accessed 
through the RMB (right mouse button) menu. 

 

GeoCivil contains a data structure which enables elements to have multiple locations; a true position 
and a distorted position. This is particularly useful in creating "surveyor's fieldnotes" for lodgement at 
the Land Titles Office, etc. In situations where a plan drawn to scale is crowded, elements can be 
moved to provide more "white space". GeoCivil will draw the elements in their distorted positions but 
adopt the dimension of the true positions. 

Displaying Distortions 
The display of distortions is controlled from the Cadastral tab of the Drawing Display Manager form. 
In the Field Notes panel, click Distortions and optionally Hide Original if only distortions are to be 
displayed. 



ePSALON Reference   

29 
 

 



ePSALON Reference   

30 
 

Creating or Editing Distortions 
From the Insert menu, choose Distortion; or click an icon from the Distortions toolbar. Available 
distortion actions are: 

 Define Edit 
A distorted position is created for a clicked Coord at the location of a second Click. If “Toggle Hide 
Originals” is OFF, the true position will be shown in addition to the newly distorted position  Parallel 
A sequence of Lines, identified by a mouse click, is distorted parallel to the original positions by 
clicking the start and end of the distortion vector. Explode 
All Coords within a specified distance are distorted radially from a clicked location Romove Single 
The distortion is removed from a clicked Coord. Remove All 
All distortions within the current project are removed Toggle Distortions ON/OFF 
Toggles On or Off the display of distorted Coord positions. Toggle “Hide Originals” ON/OFF 
If Distortions are currently displayed, this toggles On or Off the display of the true locations. 

  

 

Define/Edit Option 1067 

Parallel Option 1486 

Explode Option 1001 

Remove Single Option 1358 

Remove All Option 1002 

Toggle Distortions ON/OFF Option 1595 
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Distortion Example 

If we consider a typical cadastral survey situation, where we have a traverse around a block bounded 
by roads: 

 

If we zoom in on the NW corner we see the detail. 

 

To see this more clearly and enable us to place dimensions this detail requires distortion. This 
distortion can be effected by one of three methods: 

• Dragging a single Coord 
• Dragging all selected Coords 
• Exploding all Coords within a specified radius of a clicked location 

To differentiate the distorted lines from their undistorted locations, the undistorted lines are shown 
dashed. 
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Distorting a Selection 
Using the Selection tool a group of elements can be selected (for example within a box or polygon) 
and then distorted; see Option 1315 – Distort Selected Elements. 

The Selection tool also facilitates the parallel distortion of an element series; see Option 1486 – 
Distort Line Sequence Parallel. 

 

 

The above screen grab shows the distorted NW corner achieved by first "exploding" the related 
Coords by a factor of 5 then individually dragging some Coords. The dashed lines show the individual 
distortions; the thicker lines being the distorted positions. The display of distortions is controlled from 
the Configure Display tool. 

In the Field Notes panel checking the Distortions box will turn the distortions ON. Checking the Hide 
Original box will leave only the distorted elements displayed (as is seen below). 

 

With dimensions added the distorted drawing is produced. 
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NOTE: 

From the Distortions toolbar you can toggle the display of Distortions ON or OFF (see option 1595) or 
toggle the display of the original elements (see option 1596). 

Multi-Sheet Distortions 
If multiple drawing sheets are defined, different distortions can be applied to the Coords on each 
sheet if required.  If a distortion is made when a “current sheet” exists, the distortion will only apply to 
that sheet. 
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Data Preparation Using AutoCAD 

If a subdivision is created in AutoCAD, endeavour to follow the conventions of GeoCivil where 
possible and then save the data in DWG or DXF format (version 2004 or earlier). 

In GeoCivil, import the AutoCAD created subdivision using Import > DWG / DXF. Using a translation 
table it is possible to match the AutoCAD layer names to those of the GeoCivil CADASTRAL level, but 
this is not essential as through the GeoCivil Selection tools you can make a selection of elements and 
assign them to the current GeoCivil feature. 

GeoCivil also allows the easy assignment of ePlan parcel classes to AutoCAD polygons; or simply 
create the parcels in GeoCivil. 

Note: Geocomp Consulting can provide guidance as to how best to structure your AutoCAD data and 
to most efficiently transition it to create an ePlan CIF. 

 

 

Data Preparation Using Civilcad 

If a subdivision has been created in Civilcad, endeavour to follow the conventions of GeoCivil where 
possible and then export the data in AS5 format. 

In GeoCivil, import the Civilcad created subdivision using Import > Civilcad AS5. Using a translation 
table it is possible to match the Civilcad layer names to those of the GeoCivil CADASTRAL level, but 
this is not essential as through the GeoCivil Selection tools you can make a selection of elements and 
assign them to the current GeoCivil feature. 

GeoCivil also allows the easy assignment of ePlan parcel classes to Civilcad polygons; or simply 
create the parcels in GeoCivil. 
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  ePSALON Data 
Finalisation 

This chapter describes how to generate the finalised 
ePlan format data from that created in the third party 
packages addressed in the previous sections. 

 

Note: Currently we are working on translations from AutoCAD and CivilCad 
packages. For the interim the examples and instruction given in this chapter 
addresses GeoCivil generated data only. 
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ePlan Data Generation 

Required: 

o GeoCivil .NP containing ePlan relevant data. 

o Digital Base Data taken from SPEAR website. Take care to only select what is needed. 

o Plan information (Face sheet and notes) 
 

Process: 

1. Start ePSALON by double clicking its shortcut icon,     
2. Start the ePSALON ePlan generation Wizard 

Procedure: 
1. From the File menu, choose ePlan Wizard 

 

 

2. A welcome screen is shown – click the “Next” button 
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3. Click the “Import” buttons to enter the GeoCivil and the 
SPEAR base data files. As the files are imported they will be 
converted to a ePlan or CIF format file. Then click the “Next 
Step” button. Clicking the Save button throughout the wizard 
process will save a file containing the process done so far. 
Save and exit will do the same, as well as exit the 
application. 

 

 

4. Add the Surveyor and Survey Firm details into the form text 
boxes. Drop down lists are provided for some entries. The 
surveyor details can be saved for later use by giving a name 
to the entries and clicking the Add button. When ready to 
proceed click the “Next Step” button. 
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5. Add the survey information such as the survey purpose, 
depth limitation, title reference and the like. Proceed through 
the Tabs at the top of the form completing the details as 
required. Use the drop down options where provided.  

i. For the Survey Information tab: after selecting the 
appropriate head of power and purpose of survey, 
click add new to add another. Select the date it was 
surveyed from the calendar.  

ii. For the Title Reference tab: after entering the 
Surround Parcel and the Title Reference click the 
Add button. If needed, select one from the Entered 
Title References list and click remove. 

iii. For the Depth Limitation tab: after entering the Origin 
Parcel click the Add button and on the form that 
appears select those new parcels that inherit the 
depth limitation, then click the Ok button. If a Depth 
Limitation parcel was created in GeoCivil, enter the 
depth after selecting the Depth Limitation parcel. 
Then click the Ok button. 

iv. For the Easement tab: after selecting the Easement, 
click Assign Beneficiary. In the window that pops up 
either select a parcel from the list as land benefitted 
or manually enter a beneficiary then click the Ok 
button. 

v. For the Vesting Authority tab: Select the Parcel and 
enter the Vesting Authority, then click the Add 
button. 

vi. For the Annotation tab: Enter the details of the 
Annotation, select a Parcel Reference if needed and 
click the Add button.  

vii. For the Restriction tab: after entering the Restriction 
Parcel click the Add button, edit the descriptive text, 
select the Benefited and Burdened parcels, and click 
the Save button.  

viii. For the Owners Corporation tab: enter the 
Entitlements and Liabilities, the State, the Use of 
Parcel and the Owners Corporation notation. 

ix. For the Amendment tab: enter the Dealing Number, 
Comments and Amendment Date and click the Add 
button. 

x. For the Control Points tab: This tab shows the 
Horizontal and Vertical Control Point Information, if a 
value is incorrect, you can edit it by clicking on the 
value and changing the text. 

When ready to proceed click the “Next Step” button.  
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6. Add the Location Address details. Select each parcel list in 
the text box on the form and assign an address. When ready 
to proceed click the “Next” button. 

 

A CIF file viewing application window appears showing at left, in 
an expandable tree structure, the completed CIF format file, and 
at right the related subdivision graphics (see below).  
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Under the File drop down menu of this application the CIF file 
can be saved or another CIF file opened and viewed. The View 
drop down menu can be used to zoom in and out of the graphics 
pane, to turn on and off different graphic features, and to view 
the same file in XML format. The Tools menu can be used to edit 
the CIF file, for instance if data was omitted from or incorrectly 
entered during the previous Wizard phase of data entry. Ticking 
the Info option under the tools menu enables the user to select 
features in the graphic window and have their corresponding 
entry in the CIF file found and expanded. By right clicking on 
some of the directory or tree structure headings and then clicking 
the edit option in the menu that appears it is possible to edit the 
contents of the CIF file. 

When satisfied with the file this window can be closed and then 
in the main ePSALON application window the file exported to 
ePlan XML format (see below). This generated XML file can then 
be submitted to SPEAR for validation. 
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  Frequently 
Asked Questions 

This chapter answers frequently asked questions 
regarding the use of the GeoCivil and ePSALON for 
ePlan data generation. 
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This section is currently being developed. 
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  Glossary 

This chapter lists and defines commonly used terms 
in this document and the broader land survey 
industry. 
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A 
accuracy:  Conforming to a recognizable standard. If applied to paper maps or map 

databases, degree of conformity with a standard or acceptable value. The 
statistical meaning of accuracy is the degree with which an estimated mean 
differs from the true mean. 

adjustment:  Term for the process of corrections applied to a measurement or set of 
measurements. 

AGD:  Australian Geodetic Datum. The framework used for coordinates in Australia 
since 1966. It has been superseded by the Geocentric Datum of Australia 
(GDA). 

AGD66/84:  Australian Geodetic Datum 1966/1984. See AGD. 

AHD:  Australian Height Datum. The datum used for the determination of elevations 
in Australia. The determination used a national network of bench marks and 
tide gauges, and set mean sea level as zero elevation. 

altitude:  The vertical distance of a level, a point or an object considered as a point, 
measured from mean sea level. 

AMG:  Australian Map Grid. A Cartesian coordinate system based on the Universal 
Transverse Mercator projection and the Australian Geodetic Datum. The unit 
of measure is the metre. 

AMG Grid:  Grid derived from AMG coordinates. 

annotation:  A text based graphic element. 

arc:  An element defined by up to four Coords (start and end tangent points, centre 
point, optional circumference point if a "three point arc") and possessing 
element properties. 

area:  A fundamental unit of geographical information. 

ASCII:  The American Standard Code for Information Interchange. A standard that 
maps commonly used characters such as the alphabet onto one byte long 
sequences of bits. 

attribute:  A user definable property inserted into drawings 

Australian Geodetic Datum:  The framework used for coordinates in Australia since 1966. It has been 
superseded by the geocentric datum of Australia (GDA). 

Australian Map Grid:  A Universal Transverse Mercator Map Projection. 

azimuth:  Geographic orientation of a line given as an angle measurement in degrees 
clockwise from north. 

B 
base mapping:  Usually associated with topographic mapping covering country or region at 

different scales. 

block:  A grouping of drawing elements stored with the drawing and referenced from 
the drawing itself. 

BMP:  An abbreviation for Windows Bitmap. BMP is a common raster data format 
supported by many Microsoft Windows products and applications. 

C 
CAD:  Computer Aided Drafting. 

cadastral map:  A map showing the precise boundaries and size of land parcels. 

cadastral survey:  A survey of the boundaries of land parcels. 

cadastre:  A record of interests in land, including both the nature and extent of interests. 
Usually this means maps and other descriptions of land parcels as well as the 
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identification of who owns certain legal rights to the land. Cadastral 
information often includes other descriptive information about land parcels. 

calibration:  The act or process of comparing certain specific measurements in an 
instrument with a standard. 

Cartesian coordinate system:  A system of two or three mutually perpendicular axes along which any point 
can be precisely located with reference to any other point, often referred to as 
x, y and z coordinates. Relative measure of distance, area and direction are 
constant throughout the system. 

circle:  An element defined by a centre point Coord plus radius and possessing 
element properties. 

COGO:  Coordinate geometry 

command window:  Dockable toolbar for entering numeric commands and for viewing command 
instructions. 

contour:  A line connecting points of equal value (e.g. elevation), often in reference to a 
horizontal datum such as mean sea level. 

contour interval:  The vertical difference in measurement units such as meters or feet, between 
successive contour lines on a contour map. 

control:  A system of points which are used as fixed references for positioning other 
surveyed features. 

coordinate:  The position of a point n space with respect to a Cartesian coordinate system 
(x, y and/or z values). In a GIS, a coordinate often represents locations on the 
earth’s surface relative to other locations. 

coordinate name / number:  Each coord can be assigned a unique name (e.g. PSM101, 2345, ETCH01, 
etc). An automatically assigned incrementing number may also be assigned. 

coordinate system:  A systems used to measure horizontal and vertical distances on a plan metric 
map. In a GIS, it is the system whose units and characteristics are defined by 
a map projection. A common coordinate system is used to spatially register 
geographic data for the same area. 

coordinate, geographic:  A system of spherical coordinates for describing the positions of points on the 
earth. The declinations and polar bearings in this system are the latitudes and 
longitudes respectively. 

D 
data capture:  The process of encoding data. In terms of mapping this involves digitising of 

analogue maps or capture of field data using electronic instruments and 
associating this with encoded attribute data. 

database:  An organised, integrated collection of data stored so as to be usable for a 
variety of purposes. 

datum:  Fixed starting point for field survey, from which other survey data may be 
accurately compiled. Generally facts known or granted, a premise from which 
inferences may be drawn. 

digitising:  The process of converting analogue etc to a computer readable form. 

dimension:  A bearing and/or distance descriptor attached to lines, arcs or points in a 
dataset. 

drawing:  A hardcopy ready, CAD representation of the current dataset. 

Drawing Editor:  A CAD style tool within GeoCivil, for creating, editing, manipulating, 
exporting, or printing DWG format drawings. 

E 
EDM:  Electronic Distance Measurement. Measurement of distance by means of 

electromagnetic transmissions, including radio, visible high, laser and infrared 
light. 
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element:  Point, Line, Arc or Circle possessing properties of Level, Feature, 
Description, Surface(s) and Status (Deletion flag). 

elevation:  The vertical distance from a datum, usually mean sea level, to a point or 
object on the earth's surface. 

engineering surveying:  Surveying associated with the setting out and monitoring of engineering or 
construction works. 

entity:  A unique numeric identifier assigned to a feature. 

F 
feature:  A representation of a real world object in the data. 

Feature Definition:  A Feature Definition contains the current Features and Feature Settings. It 
allows the user to set a different Feature Definition (and thus different 
Features and Feature Settings) for different projects. 

G 
GDA:  Geocentric Datum of Australia. A new coordinate framework for Australia 

which is compatible with the Global Positioning System (GPS). The GDA was 
adopted in 1994 and officially implemented in the year 2000. 

geocentric datum:  A datum based on the earth's centre of mass (or geocentre). 

Geocentric Datum of Australia:  A coordinate framework for Australia which is compatible with the Global 
Positioning System (GPS). 

geodesy:  The study of the size and shape of the Earth's surface, the measurement of 
the position and motion of points on the surface and the configuration and 
area of large portions of its surface. 

geodetic control:  A network of sites for which precise positions and/or heights are known and 
for which the shape and size of the Earth are taken into account. 

geodetic surveying:  The determination of the position of points on the earth’s surface accounting 
for its curvature, rotation and gravitational field. 

geographic information:  Also land information and spatial information - information that can be related 
to a location on, above or beneath the earth’s surface, including water 
surfaces. 

geographic information system:  An organized collection of computer hardware, software, geographic data and 
personnel designed to efficiently capture, store, update, manipulate, analyse, 
and display forms of geographically referenced information. A system for 
capturing, storing and using data which is spatially referenced. Often the term 
is associated with a specific set of information technology components. 

geographical coordinates:  A position given in terms of latitude and longitude. 

geographical data:  Data that record the location and a value characterizing the phenomenon. 

geographical grid:  Grid derived from geographical coordinates (commonly referred to as 
longitude and latitude). 

GIS:  Geographic Information System. A computer based system used to capture, 
create, maintain, display and analyse spatially related information. 

GPS - Global Positioning System: A satellite based navigation system developed by the United States 
Department of Defense and now widely used for civilian navigation and 
positioning. 

graticule:  A grid of parallels and meridians on a map. 

grid:  1. a set of regularly spaced sample points. 2. In cartography, an exact set of 
reference lines over the Earth’s surface. 

grid convergence:  The angular difference in direction between Grid North and True North. It is 
measured east or west from True North. 
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J 
join toggle:  Allows new Coords to be strung as Lines as they are created. 

L 
land:  Includes the space above and below the surface. 

land information management:  The activity of capturing, organising, integrating, managing and distributing 
digital land related information and derived products for use by government 
and the community. 

Land Information System:  A system for capturing, storing and using spatially referenced data. Usually 
not associated with specific technologies and used as the generic term for 
land / geographic / spatial information systems including the institutional 
framework and standards established to create and manage the LIS across 
the government and community. 

land parcel:  An area of land that is uniquely defined for ownership or land use purposes. 
Each parcel has a unique location, lot and plan identifier. 

latitude:  The latitude of a place is its angular distance on a meridian, measured 
northwards or southwards from the terrestrial Equator. 

legend:  The part of a map that is used to explain the meaning of the symbols used to 
depict geographical information and to provide the user with other information 
on the information depicted. 

level:  A grouping of features by type. 

line:  An element defined by a pair of Coords and possessing element properties. 

LIS:  Land Information System. Synonymous with GIS although more often 
associated with cadastral based systems. 

longitude:  A method of measuring the earth representing angles of a line extending from 
the centre of the earth to the earth’s surface. A line extending from the north 
to the south pole through Greenwich, England, represents 0 degrees. Each 
line of longitude runs north and south and measures the number of degrees 
east or west of the Prime Meridian. Values range from positive 180 to 
negative 180 degrees. Lines of longitude are often called ‘meridians’. 

M 
map:  A record, either in analogue or digital form that describes the spatial 

distribution of geographical features in a specified area. 

Map Grid of Australia 1994 

(MGA94):  A Cartesian coordinate system based on the Universal Transverse Mercator 
projection and the Geocentric Datum of Australia 1994. The unit of measure 
is the metre. 

map projection:  A mathematical model for converting locations on the earth’s surface from 
spherical to planar coordinates, allowing flat maps to depict three-
dimensional features. Some map projections preserve the integrity of shape, 
others preserve accuracy of area, distance or direction. All map projections 
distort shape, area, distance or direction to some extent. 

map units:  The coordinate units in which the geographical data are stored, such as 
meters, or degrees, minutes and seconds. 

Mercator projection:  The conformal cylindrical projection tangential to the Equator, possessing the 
additional valuable property that all rhumb lines are represented by straight 
lines. Used extensively for hydrographic and aeronautical charts. 

meridian:  A line running vertically from the north pole to the south pole along which all 
locations have the same longitude. The prime meridian (0 degrees) runs 
through Greenwich, England. Moving left or right of the prime meridian, 
measures of longitude are negative to the west and positive to the east, up to 
180 degrees (half-way around the globe). 
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mining surveying:  Associated with the construction, monitoring and mapping of mines and 
associated works. 

N 
nautical mile:  A measure of distance equal to one minute of arc of a great circle on the 

earth's surface. The International Nautical Mile is equal to 1852 metres. 

northings:  The y-coordinates in a plane-coordinate system. 

O 
orthographic projection:  The projection by parallel rays onto a plane at right angles to the rays. 

P 
photogrammetry:  A series of techniques for measuring position and altitude from aerial 

photographs or images using stereo viewing. 

pixel:  One picture element of a uniform raster or grid line. Often used 
synonymously with cell. 

plan:  A hardcopy representation of a dataset viewed perpendicular to the XY plane. 

point:  A single x, y coordinate that represents a geographical feature too small to be 
displayed as a line or area, e.g. a power pole. 

polygon:  A vector representation of an enclosed region, described by a sequential list 
of vertices. 

positional accuracy:  statistical estimate of the degree to which planimetric coordinates and 
elevations of features agree with their real world values. 

precision:  If applied to paper maps or map databases, it means the accuracy of 
definition; (2) if applied to data collection devices such as digitisers, it is the 
exactness of the determined value; (3) the number of significant digits used to 
store numbers. Note: precision is not the same as accuracy - a large number 
of significant digits doesn't necessarily indicate that the measurement is 
accurate. 

property:  A general term describing a person’s possessions. "real property" refers to a 
piece of land owned by a person. 

R 
raster image:  A cellular data structure composed of rows and columns. Each cell has a 

value which represents an attribute value for the feature represented by that 
image. 

RDBMS:  A database management system with the ability to access data organized in 
tabular files that may be related together by a common field (item). An 
RDBMS has the capability to recombine the data files from different files, 
providing powerful tools for data usage. 

rectify:  The process by which an image or grid is converted from image coordinates 
to real-world coordinates. Rectification typically involves rotation and scaling 
of grid cells and thus requires re-sampling of values. 

relational database 

management system:  A database management system with the ability to access data organized in 
tabular files that may be related together by a common field (item). An 
RDBMS has the capability to recombine the data files from different files, 
providing powerful tools for data usage. 

remote sensing:  The technique of obtaining data about the environment and the earth from a 
distance - e.g. from aerial photography or satellites. 



ePSALON Reference   

49 
 

resolution:  1. The size of the smallest feature that can be represented in a surface. 2. 
The accuracy at which the location and shape of map features can be 
depicted for a given map scale. In a large scale map (e.g. a map scale of 
1:2500) there is less reduction of features than those shown on a small scale 
map (e.g. 1:1,000,000). On a larger scale map feature resolution more 
closely resembles real-world features. As map scale decreases, resolution 
also diminishes as feature boundaries must be smoothed, simplified or not 
shown at all. 

S 
satellite imagery:  Images of the earth taken from orbiting satellites. Images can be taken in a 

variety of forms so as to detect specific information about the earth, 
vegetation and other types of land cover. 

scale:  The relationship existence between distance on a map and the corresponding 
distance on the earth. It is usually expressed in the following form 1:10,000, 
meaning that 1 unit of measurement on the map represents 10,000 of the 
same units on the earth’s surface. A ‘ large’ scale map is one in which a given 
part of the Earth is represented by a large area on the map. Large scale 
maps generally show more detail than small scale maps because at a large 
scale there is more space on the map in which to show features. Large scale 
maps are typically used to show site plans, local areas, neighbourhoods, 
towns etc. 1:2,500 is an example of a large scale. A ‘small’ scale map is one 
in which a given part of the Earth is represented by a small area on the map. 
Small scale maps generally show less detail than large scale maps, but cover 
large parts of the Earth. Maps with regional, national, and international 
extents typically have small scales, such as 1:1,000,000. Large scale maps 
typically show more detail than small scale maps, whereas on smaller scale 
maps there is simply not enough room to show all the available detail, so 
features such as streams and roads often have to be represented as single 
lines, and area features like cities, have to be shown as points. This is called 
generalization. 

selection:  Group of elements or texts selected by the user and available for many 
manipulations by the user. 

spatial information:  Information which includes a reference to a two or three dimensional position 
in space as one of its attributes. 

subdivision:  The process whereby a parcel of land is divided into two or more parcels or 
alternatively multiple parcels are consolidated into one or more parcels. 

surface:  A grouping of related contourable elements. Up to fifteen surfaces can be 
defined for a particular dataset. 

survey plan:  A plan prepared by a surveyor from field survey data and previous survey 
plan data according to standards and directions of the governing body. 

surveying:  The measurement of dimensions (contour, position, boundaries, area, height 
etc.) of any part of the earth's surface (land or water) or any cultural feature. 
Depending on the type of survey undertaken and the degree of accuracy 
required, "surveys" may involve the application of the theory, principles and 
techniques of geodesy, photogrammetry and cartography. 

T 
tile:  A part of a geographic data base that depicts a specific area of the earth’s 

surface. Many geographic data bases are arranged in tiles or digital map 
sheets to enhance computer performance and easy of use. Increasingly 
geographical data bases are arranged in "seamless" form so that tiles 
become irrelevant. 

title:  The evidence of a person's right to land. 

topographic data base:  A data base in which data relating to the earth’s physical features on the 
earth’s surface are held and managed. 
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topographic map:  A map showing the features on the earth’s surface in accuracy and details 
appropriate to the map scale. A standard topographic map will show a 
number of different themes of data - e.g. contours, water features, cultural 
features (roads, buildings, etc). 

topographic surveying:  Involves establishing the contour level and interval of the earth's surface 
above and below sea level based on a particular control survey system. 
These surveys may be done by aerial, photogrammetric and ground survey 
and involves recording of natural features such as hills, streams, valleys and 
cultural features, such as roads, bridges, railways, etc. These surveys are 
used to produce topographic maps. 

topography:  Description or representation on a map of the physical and cultural surface 
features. 

topology:  A term used to refer to the continuity of space and spatial properties, such as 
connectivity, that are unchanged after distortion. In GIS, this term refers to 
the way in which geographical elements are linked together. For example the 
topology of a line includes all of its to- and from- nodes, and its left and right 
polygons. Topology is useful in GIS because some spatial modelling 
operations do not require coordinates, only topological information. 

transformation:  The process of converting data from one coordinate system to another 
through translation, projection, rotation and scaling. 

Translation Table:  Used to match GeoCivil Features to other types of data grouping identifiers, 
eg. AutoCAD DWG Layers, Survey Codes, MX string codes, etc. 

Transverse Mercator projection: A conformal cylindrical map projection, originally devised by Gauss, also 
known as the Gauss Kruaer projection. As its name implies, its construction is 
on the same principle as the Mercator projection, the only difference being 
that the great circle of tangency is now any nominated meridian. Meridians 
and parallels are curved lines, except for the central meridian or a specified 
zone (meridian of tangency), which remains a straight line. Projection zones 
are established about the central meridian and vary in width from two 
degrees to six degrees of longitude, with some overlap between zones. The 
amount of scale distortion may become unacceptable at distances greater 
than about 1.5 degrees in longitude from the central meridian. In a modified 
form the projection is in general use for topographic mapping at scales of 
1:250 000 and larger. See Universal Transverse Mercator projection. 

U 
Universal Transverse Mercator:  A widely used planar coordinate system, extending from 84 north to 80 south 

latitude and based on a specialised application of the Transverse Mercator 
projection. The extent of the coordinate system is broken into 60, 6 degrees 
(longitude) zones. Within each zone, coordinates are usually expressed as 
meters north or south of the equator and east from a reference axis. For 
locations in the Northern Hemisphere, the origin is assigned a false easting of 
500,000 and a false northing of 0. For locations in the Southern Hemisphere, 
the origin is assigned a false easting of 500,000 and a false northing of 
10,000,000. 

V 
vector data:  Positional data in the form of coordinates of the ends of line segments, 

points, text position, etc. 

W 
WGS84:  World Geodetic System 1984. A geocentric geodetic datum used for the 

determination of geographical coordinates developed by the United States 
Department of Defence. For all practical purposes, GDA94 approximates to 
WGS84. 
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This section is currently being developed. TO BE COMPLETED. 

 

 

 

 


